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A BROKER ON YOUR SIDE

1Installation
STEP1

Run the FXCC_MultiTerminal_Setup.exe file, read through the information and click the
"Next" button to continue.

¥ FXCC - MetaT >
I FX CENTRAL CLEARING

Welcome bo FXCC - MetaTrader 4 Setup!

The client terminal is designed For performing trade operations in different financial markets, The
terminal also offers wide analvtical possibilities and supports warious tools For conducting
technical analysis,

Program conkains all the necessary tools for developing, testing and running programs For
automated trading (Expert Advisors), These programs are written in the built-in language, using
which you can also create custom indicators and scripts,

Unauthatized reproduction or distribution of this prograrm; or any portion of it, may result in severe civil and
chiminal penalties, and will be prosecuted to the maximurn extent possible under law,

— FEx Central Clearing Ltd,

< Bk Mext > Cancel

STEP 2

Read through the End-User Licence Agreement and click the "Yes, | agree with all terms of this
license agreement” box to agree with the terms, and then click the "Next" button to continue.

[ W) TCC - MetaTrader 4 Setup (32 bit)

EACC

X CENTRAL CLEARING

METAQUOTES SOFTWARE CORP, Et
Trading Terminal End-User License Agresment

Plaace read carefully the terme and conditions of thic Agrearment. Thic Agreement uces
sorne of the definitions set out in paragraph 1 below.

This Agreement, and any nesy versions, between MetaQuotes Software Corp., and You,
covers all Your use of Trading Terminal from any computers where Trading Terminal has
been installed, by You or by third parties, You can accept this Agresment by clicking on
the Teext” button or “Accept” button or similar buttons or links a5 may be designated by
MetaQuotes Software Corp,

Your agrecment with MetaQuotes Software Corp. may also incude the Additional Terms
(e et wed Lshowe). Thee Adivnal Terie shall iwhade, bt are ool linfled Ly, e Ve
and policies set out in the current Agreement.

[T es, 1 ayres with o Lermes of Uik buovse agesml

« Back | I Cancel [
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1Installation
STEP3
Select the installation folder, then click "Next".

¥ FXCC - MetaTrader 4 Setup (32 bit) B3

EACC

X CENTRAL CLEARING

Select the destination folder where you want to install FXCC - MetaTrader 4. Toinstall to a
different location, click Browse, and select another folder,

GBS E NG L E R \Program Files\FXCC - MetaTrader 4 Browse... I

Select the Start Menu program group in which you would like Setup to create the shortcuts,

Program group: I FXCC - MetaTrader 4

Select the additional tasks you would like Setup to perform while installing.
¥ Create a desktop shortcut
[V Launch program after successful installation

FX Central Clearing Ltd, -

< Back Next > Cancel

STEP 4

Once the installation process has been completed click the "Finish"” button.

¥ FXCC - MetaTrader 4 Setup [32 bit)

EXCC

FX CENTRAL CLEARING

Installation progress (32 hit)

" Selact best access point: 4.cdn.metagquates.net
/" Download files

14942 kb

Create directories

5
F

Installation successfully completed. Cick the “Finish” button to exit

[Fw ] oo |
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2 Terminal
Main Menu
b4 FXCC - MetaTrader 4 MultiTerminal - FXCC-Dem
Fle Edt View Tools Window Help
% :EII .?.ﬂ. Mew Account @ FE‘, &_3
2.1File Menu

ES FXCC - MetaTrader 4 Multil

Fle | Edt View Toos V
=
& Mew Account...
Prirt Setup...
Exit
Mew Account L :EJ_I_J&
This form allows you adding a new account
for the server 'FXCC-Demo'.
Login: |
Password:
[ OK l [ Cancel

1. Connect all: Connect all listed accounts.
2. Disconnect all: Disconnect all listed accounts.

3. New account: User can add a new account to the list of managed accounts.
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2.2 Edit Menu
This menu offers Find and Copy commands.
Copy Find
| Edt [ View Tools W Edt | View Tools W
B coy  amc | @y Copy Qs
1 4 Fnd.  CisF G Fnd.  CueF
| & FndNed F2 f FndNet  F3

After clicking on the Find Menu item, a window appears where the user can search for what they

require.
Find (0] )
,&] Find what: -
[ concel ]
2.3 View Menu

The following options are available in the View tab:

1. Languages: Select desired language based on personal preference. The
Terminal must be restarted for the changes to apply.
2. Toolbar: Select or deselect the Toolbar option to show or hide the Terminal.

3. Status Bar: Select or deselect the Status Bar option to show or hide the Status Bar.

4. Market Watch: Select to show or hide the Market Watch window, where the quotes
(Bid/Ask) for the different financial instruments are shown.

5. Accounts: Select to show or hide the Accounts window, where the lists of all the
accounts are shown.

6. Toolbox: Select to show or hide the Toolbox window.

7. Full Screen: Select this to enable or disable the full screen mode.

2.4 Tools Menu
Options
The user can set up the core functions by selecting "Tools" Options

and then "Options". Once "Options" is selected, a window - -
P . P Server | Trade iEmaul Events
appears, showing the following tabs:
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1. Server: Contains parameters of server connections. Proxy server, personal settings and news
can be enabled.

2. Trade: Select default settings of opening new orders. Settings "Such as" the default
symbol that the user wishes to appear when opening a new order, desired lot size, lots
allocation mode and deviation.

3. Email: Set up email parameters.

4. Events: Set up settings of sounds for Terminal connection/disconnection, email, time
out and price re-quotes.

2.4.10ptions Tabs

2.4.1.1Sever

The server tab contains options for the server and data center connection.

Cptions T o
Server | Trade | Email IEverrts

Server. | FXCC-Demo - FX Central Clearing Lid -
FXCC-Demo - FX Central Clearing Ltd.
FXCC-Live - FX Central Clearing Ltd

Keep personal esttings and data at startup

Enable news

oK | [ caneel | [ Hek

In this window, ensure the "Data Center auto configuration”, "Keep personal settings and data
at startup” and "Enable news" boxes are selected. "Enable proxy server"
should remain unselected.

2.4.1.2 Trade
. . v T —— Y ||
The user has the following options to choose aim :
from: Server| Trade |Email | Events|
Symbol by default: @ Last used
Default GBPUSD
Lots by defaukt: @ Last used
Default
Lots allocation: @ Last used
Defauit total volume for each order
Deviation by default: @) Last used
Default 5 pips
0K [ Concdl | [ Heb |
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1. Symbol by default: Allows the user to set the currency pair that is displayed by default
when an order window is opened. If the user selects the "Last Used" option it means that
the latest trade will define the symbol.

2. Lots by default: The useris able to set the default amount of lots to be traded. If the "Lots
by default” option is selected then the amount is defined by the previous trade. If the user
selects the Default option then the value can manually be set.

3. Lots Allocation: The lots allocation specifies the total lots that will be distributed among the
assigned accounts based on the method selected.

a. Predefined Volume: The deal size must be predefined each time a position is
opened. If "Last Used" is selected, the predefined volume set on the previous trade

will apply.

b. Total Volume for Each Order: The total volume for each order is set and applies
equally to all allocated accounts. If “Last Used" is selected, the total volume used on
the last trade will apply.

c. Equal Parts: The total lots is equally divided and allocated to the volumes of the

assigned accounts before placing a trade.

d. By Equity Ratio: The total lots will be allocated to all assigned accounts according to
the ratio of the accounts’ equities.

e. By Free Margin Ratio: The total lots will be allocated to all assigned accounts
according to the ratio of the accounts’ free margins.

4. Deviation: Sometimes prices can move fast while the order is executed. The user can set
the maximum deviation of the order price with the market price. If the market price exceeds
the value set then the position will not be opened.

2.4.1.3 Email

Mailbox can be set in this tab. To receive emails, select the "Enable" box and fill in the required
fields, then click "OK".

T — - o ] |

-
Options

Server | Trade | Email [Events

[¥] Enable
SMTP server.
SMTP login:
SMTP password.
From

To:

o) ot ) )
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2.4.1.4 Events

The user can set signals for system events. Specific events can be disabled or enabled by double
clocking on each name.

1. Connect: Signal after a server connection.
2. Disconnect: Signal of a failed server connection.

3. Email Notify: Signal of a mail received in Inbox which can be read at the Toolbox and then
Mailbox tab.

4. OK: Signal when trade was done successfully.

5. News: Signal of receiving news, which can be read at the Toolbox and
then the News tab.

6. Requote: Signal when the price changes during the execution of a trade.

erlions T - M‘
Server | Trade | Email | Events
V| Enable
”Evem Action
2\ Connect connect wav
7\ Disconnect disconnect wav
£\ Emai Notify email wav
2 Timeout timeout wav
2 Ok ok wav
[ News news wav
2\ Requote alert wav
[ ok ][ Cancel |[ Hep |
2.5 Windows
1. Orders: Opens the Orders window. MetaTrader 4 MultiTerminal - F)
.
2. History: Opens the closed positions History window. = e ]
. v Orders unt
3. New Order: Opens the New window. _ —
ch History C
4. Close Order: Opens the Close window. New Order
5. Pending Order: Opens the Pending window. Close Order
. . . Pending Order
6. Modify Order: Opens the Modify window
Modify Order
7. Delete Order: Opens the Deleting window. Delete Order
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2.6 Help

The user can use the "Help Topics" built-in files and the "About” option e I

where information about the company and the Terminal version is shown. Help Topics  F1
™ About...

3 Meta Trader User Interface

There are four main windows in the MT4 MultiTerminal.

« Market Watch

+ Toolbar

« Accounts

« Order Management

The first three main windows can be activated by clicking "View" in the toolbar, then select
"Market Watch", "Toolbar", "Accounts"” menu sequence.

3.1 Market Watch (Real-time quotes)

The "Market Watch"” window shows you the real-time quotes of the currency pairs. Each
currency pair's Bid and Ask prices are shown, displaying in a vertical window on the left.

The "Symbol” column shows the symbol name and the "Bid" and "Ask" show the
corresponding prices the client can buy or sell from the market. If you double click

on any currency pair, then the Order window will open. This window can also be activated
by pressing the "Ctrl+M" key combination, or by the "Market Watch" under the "View" tab
on the menu command.
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Right-click on the "Market Watch" window to produce the content menu as shown:

E& FXCC - MetaTrader 4 MultiTerminal - FX(
Fle Edit View Tools Window Hel

& Connect All a a}, New Account

Market Watch: 13:27:35 = or
Symbal Eid Ask EE
£ EURUSD 111883 111636 Ea
& USDIFY 103.270 103.274 Ea
o) GB[’ 1€ M 1 JANAL hl ')Inw @
& us Tick Chart Space g
4 Usl [%] Specification ]
& AU 7
Hide Delete
& NZI 7
P Hide Al 3
% EUR &
¥ EUH Symboals. .. 3
¥ GB 1
v Auto Amange A
¥ GB 3
% AU Spread 3
& AL High/Low 5
& AU Time 0
& AU »  Gid G 9
& CH 2
& EUS BB Popup Frices F10 5

1. Tick Chart: Shows the tick chart for the selected instrument
2. Hide: Hides the specified symbol from the list in the "Market Watch" window.

3. Hide All: Hides all symbols from the list in the "Market Watch" window which are not used (if you
have open positions or charts, its symbols will not be deleted).

4. Show All: Displays all available symbols in the "Market Watch"” window.
5. Symbols: Enables the window where you can hide/show the selected instruments.

6. Auto Arrange: Automatic arranging of columns when changing the window size. Auto arrange
can also be enabled by right clicking on any symbol and pressing "A".

7. High/Low: Shows/hides columns with the highest and the lowest prices for each
instrument.

8. Time: Displays a column with the arrival time of the latest quote for each instrument.
9. Grid: Hides/unhides gridlines in the "Market Watch" window.

10. Popup Prices: Opens the popup window which contains real time quotes for your selected
instruments.
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3.2 Toolbox

3.2.1News
In the "News" tab, the incoming news will be published and arranged according to the time.

* | Time Subject

Toolbox

News | Alerts | Mailbox | Journal

3.2.2 Alerts

The "Alerts" tab allows the user to set alerts for specific conditions.

x
Symbol Condition e e e EnERIR

Toolbax
K
o

3.2.3 Mailbox

In the "Mailbox" tab the user can find the messages sent to the Terminal.

: Time To From Subject

Mews | Alerts | Mailbox | Journal |

3.2.4 Journal

The "Journal" tab shows all the operations and Time Message
« ey e . . @ 201211.0518:43.05 °514660% orderis open: #2611091 sell limit 1.00 EURUSD at 1.3000 sk 0.000...
activities which are shown as text entries. © 2012110518:4305  '514660': requestmﬂpmcess

@ 20121105 18:43:05 514660": request was accepted by server

® 2012.11.0518:43:05 '514661" orderis open: #2611090 sell limit 1,00 EURUSD at 1.3000 sk 0.000...
“514661'% request in process

@ 2012.11.05 18:43:05 514661 request was accepted by server

@ 2012.11.0518:43:05 514660 pending order sell limit 1,00 EURUSD at 1.3000 si: 0.0000 tp: 0.0000

News | Alerts | Maibox | Journal
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3.3 Accounts

In the "Accounts" section, Balance, Equity and Login plerpe. B T Marglo Len
, §514660 123456 S0054581 43922198 TRI93%
Margin level of all the accounts are shown. Hs1e61 124567 100060517 100063607  1253716%
§514667 123456910 99982692 99982692
{7\ Total, USD 2500977.90 2499 684.97

3.4 Order Management
3.4.1How to Open a Position

Market Watch: Double click the symbol you want to trade. Every account will be shown in a list
and the user must deselect the account(s) he/she does not want to open a position for.

& Connect All @ cﬂ.ﬂ, Mew Accoun

tarket Watch: 13:29:43 x|,
Symbaol Bid Ask E
¥ EURUSD 111697 111699 [T
& UsDJPY 103,272 103276 [
¥ GBPUSD 1.24060  1.24073 [y
¥ USDCHF 093006 098013
& USDCAD 132629 1.32640
¥ AUDUSD 075899 075905
¥ NZDUSD 071357 071367
& EURJFY 115349 115360
& EURGEP 090023 0.90035
¥ EURCHF 1.09469| 1.09450
¥ GEPIPY 128122 123140
¥ GBPCHF 1.21588  1.21608
¥ AUDNZD 106352 1.06370
¥ AUDCAD 1.00665  1.00677
¥ AUDCHF 074383 0.74398
¥ AUDIFY 78381 78390
e FHEIDV 1inc 282 1NC 220

1. Symbol: Shows the type of product such as currency pairs, gold spot, or silver.

2. Stop Loss: A price to close an open position at a less profitable price to the customer than
the price at the time of placing the order. If a price is not specified, zero will be entered in
this field. The Stop Loss price will be filled in red if an order was closed by the Stop Loss, or
the distance between the current price and the Stop Loss price of an open orderis less than
10 pips.

3. Take Profit: A price to close an open position at a more profitable price to the customer than
the price at the time of placing the order. If a price is not specified, zero will be entered in this
field. The Take Profit price will be in green if an order was closed by the Take Profit, or the
distance between the current price and the Take Profit price of an open order is less than 10

pips.
4. Comment: The user can include a comment for each trade. It is not obligatory but once
the trade is placed, the comment cannot be altered.

5. Total Volume: Defines the lot amount that will be allocated to the assigned accounts
according to the allocation method used
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6. Lots Allocation: When placing new orders, it is necessary to specify the total lots
allocation for all accounts. The specified total lots will be distributed among accounts
according to the specified lots allocation method:

ePredefined volume: it will be necessary to manually specify the lots amount for each order
when placing the order, later this predefined volume will apply at placing orders.

e Total volume for each order: the total lots will apply at placing each order.

eEqual parts: the total lots will be allocated among all orders in equal parts.

¢ 0n equity ratio: the total lots will be allocated among orders based on the ratio between
equities of accounts.

¢ On free margin ratio: the total lots will be allocated among orders on the ratio between free
margins of accounts. The "Lots Allocation" option allows defining

Symbel | GEPUSD, Great Biifian Pound vs US Dollar 1 Lot = 100,000 GEF -
Stop Loss: 0.00000 - T ake Prafit: 000000
Carmrment;
Toatal Wolume:  10.00 - Lats Allocation: Itutal walume far each order v]

Attention! The trade will be executed at market conditionz, difference with requested price may be significant!

[ Sell by karket I I By by b arket

3.4.2 How to Place a Pending Order

A pending order allows the user to buy or sell a symbol at a pre-defined price in the future. This
type of order is used for opening a trade position when future quotes reach the predefined level.
If the price of the market satisfies the order condition, the pending order will be executed
automatically.

If you would like to place a pending order, you need to place it under the "Pending” tab.

Symbal IGBF'LISD, Great Britian Pound we US Dollar 1 Lot = 100,000 GEF v]
Ctop Loss: 0.00000- T ake Prafit: 000000
Comment:
Total Volume: 10,00 - Latz Allocation: Itu:utal valume far each arder v]
OpenFrice:  0.00000%] [Buplimt  +| Expi: [ 10/10/2016 135¢ =
I Flace I

There are four types of pending orders available:

1. Buy Limit: Place a Buy order, provided the future "Ask" price is equal to the pre-defined value.
The current price level is higher than the value of the placed order. This type of order is usually
placed in anticipation that the symbol price, having fallen to a certain level, will increase.

2. Buy Stop: Place a Buy order, provided the future "Ask" price is equal to the pre-defined
value. The current price level is lower than the value of the placed order. This type of orderis
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usually placed in anticipation that the symbol price, having reached a certain level, will
continue torise.

. Sell Limit: Place a Sell order, provided the future "Bid" price is equal to the pre-defined value.

The current price level is lower than the value of the placed order. This type of order is usually
placed in anticipation that the symbol price, having increased to a certain level, will fall.

. Sell Stop: Place a Sell order, provided the future "Bid" price is equal to the pre-defined value.

The current price level is higher than the value of the placed order. This type of order is usually
placed in anticipation that the symbol price, having reached a certain level, will continue to
fall.

After selecting "Pending Order”, you can select the following parameters:

1.

2.

Symbol: The type of product you wish to trade.

Stop loss: A price to close an open position at a less profitable price to the customer than the
price at the time of placing the order. If a price is not specified, zero will be entered in this
field. The Stop Loss price will be filled in red if an order was closed by the Stop Loss, or the
distance between the current price and the Stop Loss price of an open orderis less than 10

pips.

. Take profit: A price to close an open position at a more profitable price to the customer than

the price at the time of placing the order. If a price is not specified, zero will be entered in this
field. The Take Profit price will be in green if an order was closed by the Take Profit, or the
distance between the current price and the Take Profit price of an open order is less than 10

pips.

. Comment: The user caninclude a comment for each trade. It is not obligatory but once the

trade is placed, the comment cannot be altered.

. Total Volume: Defines the lot amount that will be allocated to the assigned accounts

according to the allocation method used

. Lots Allocation: The lots allocation specifies the total lots that will be distributed among

the assigned accounts based on the method selected.

Open Price: Price level at which the order will be triggered.

. Type: Buy Limit, Buy Stop, Sell Limit, Sell Stop.

. Expiry: The execution will be pending if Expiry box is not selected. If the box is selected, the

date can be set on the preferred pending order. The selected pending order will be deleted
after the specified date.

Click the "Place” button to complete your order. You can also see your order in "Trade" in the

"Terminal”.
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3.4.3 How to Close an Order

Clients can close their open positions from the "Close" tab and select the financial instrument
in the "Symbol" section. The user must select the account(s) he/she wants to close a position
forand leave unselected the positions he/she wishes to remain open.

Syrabol: IGBPUSD, Great Britian Pound vs US Dallar 1 Lot = 100,000 GEP ']

Attertion! The rade will be executed at market conditions, difference with requested price may be significant!

I Cloze

Trade Yolume Action

I Close

[V £23283177 sell 10.00 GBPUSD at 1.24059 10.00 I Close 10.00 at market

3.4.5 Multiple Close By Order

It is possible to close more than one positions of opposite direction and same financial instrument
simultaneously. In the "Multiple Close By" tab, every account that has open

positions of the same financial instrument and different direction to the position of the managed
account will be presented in alist. Do not select the positions that wish to be remained open.
After selecting the desired positions, the user can select

"Multiple Close By".

Syt [BBPUSD, Greas Bitain Pound va UFS Diker

Mgl Closn By

F sueien 12456

P sueen, 1320567
2610997 by 300 GEPUSD a4 1 55644
2010998 148 1.00 GRPUSD ot 159606
2611001 Buy 1.00 GERUSE 2 159641

Phdipis Ciona By =

The "Multiple Close By" function will lead to the opening of a new position, if the difference
between open positions of the same financial instrument that are opposite direction is not
equal to zero. This new position will follow the earlier opening time.

Considering that earlier orders are closed first, the newly opened trades will continue to
participate in the "Multiple Close By" function until all positions are closed.

3.4.6 How to Modify an Order

To modify a position, the user must use the "Modify" tab. Modifying a current position can be setting
of stop losses and/or take profits, or in the case of pending orders, setting an expiry date or
changing the open price.

Users can select the orders they wish to modify and enter the new details, clicking "Modify"

to complete the update.

Symbct [EURUSD, Euo va US Dole
Stop Loss [ 0.000003- Taka Pookit [J] 30000 -
Opem e Eipwr
Maodily
Aecount Tiade

 oe2530401 semoIBEURUSD At | Mediy 2537401
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3.4.7 How to Delete an Order

Use the "Delete" tab if you need to delete a pending order. Users can select any orders to delete using
the check boxes and delete by clicking the "Delete" button.

Symbat. [EURUSD, Eveo va US Dodor
Dekete
A Trde
Fasews 0 e
% S2611081 sell st 1 50 EURUSD at 1.30000 Belete #2611081
7 s1a61, 1234561
' =2611090 self Bt 100 EURUSD af 1.30000 Delete =3611050

For further assistance regarding the MT4 MultiTerminal application, please feel free to contact us:

Phone : +357 25 870750, +357 25 025001 | Email: support@fxcc.com | Chat: Chat now
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